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10 Graphs

4th Dimension allows you to create a wide variety of two- and three-
dimensional plots without having to export the data to a graphics 
package. You can create graphs from the data in your database or from 
data that has been copied to the Clipboard from another application. 
You can graph data directly from fields or you can graph the results of 
calculations on data. You create graphs in 4th Dimension using the 
built-in 4D Chart plug-in. 

Because graphing capability is fully integrated into 4th Dimension, you 
can graph data in your database and update your graphs when the 
information in the database changes. You can print your graphs or 
copy them to the Clipboard and paste them into other applications.

Finally, 4D Chart adds over 100 commands to the 4th Dimension 
language which enable you to control tasks that you normally perform 
manually. For example, you can use 4D Chart commands to create new 
graphs, modify graph features, open and save documents, and execute 
any 4D Chart menu command. For information on these commands, 
please refer to the 4D Chart Language Reference manual.

Managing 4D Chart Documents and Windows
4D Chart documents can be created in plug-in areas on forms or in 
separate plug-in windows. This section explains how to create, open, 
and save 4D Chart documents in both types of areas.

This section explains the basics of managing 4D Chart documents, 
including:

■ Using 4D Chart in a plug-in window

■ Using 4D Chart in a 4th Dimension form
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■ Hiding and showing 4D Chart features

■ Creating a new document

■ Opening an existing document

■ Saving a document

■ Setting the document size.

Using 4D Chart in a 
Plug-in Window

You can use 4D Chart in its own window. When used in its own win-
dow, 4D Chart operates as if it were a separate application.

When you open 4D Chart in a plug-in window, the window has its own 
menu bar. 4th Dimension’s menu bar remains at the top of the screen.

When you expand the window to full screen size by clicking the win-
dow’s zoom box, 4th Dimension’s menu bar remains at the top of the 
screen and 4D Chart’s menu bar remains within the 4D Chart window.

Opening 4D Chart in a 
Plug-in Window

The 4D Chart command appears automatically as an item in the Plug-
ins menu. If you have installed additional plug-ins that can be accessed 
in their own windows, they appear in the same menu. 

❿❿❿❿ To open 4D Chart in its own window:

1 In the User environment, choose 4D Chart from the Plug-ins menu.

A new 4D Chart document opens in its own window. 

You can open additional 4D Chart windows by choosing 4D Chart 
again from the Plug-ins menu. Opening several 4D Chart documents at 
the same time allows you to compare documents, copy and paste 
between documents, and move from one document to another simply 
by clicking in the appropriate window.

Title bar

Document area

Zoom box

4th Dimension 
menu bar

4D  Chart menu bar
Close box

Object Tool palette
Graph Tool palette
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The titles of all 4D Chart windows appear at the bottom of the Plug-ins 
menu. You can bring any document to the front by choosing it from 
the Plug-ins menu.

When you save a document, its title bar displays the document name, 
plus the suffix “(CT)”, which distinguishes 4D Chart

 

 

 

documents from 
documents created by other plug-ins. 

You can close a plug-in window at any time by clicking the window’s 
control-menu box (on Windows) or the close box (on Macintosh).

 

Using 4D Chart in a 
Form

 

You can place a 4D Chart area in any form. When you use 4D Chart in 
an input form, you can display a graph for each record in the table. 
You can also use a 4D Chart area in an output form.

When 4D Chart is used in a form, the 4D Chart menu bar appears at 
the top of the 4D Chart area. You can choose menu commands from 
either the 4

 
th

 
 Dimension menu bar or the 4D Chart menu bar. 

����

❿❿❿❿

 

To expand a 4D Chart area: 

 

1 Choose Go to Full Window from the 4D Chart File menu. 
OR
Click the 4D Chart area’s zoom box. 

 

The document expands to fill the entire screen, and 4D Chart’s menu 
bar temporarily replaces 4

 

th

 

 Dimension’s menu bar.

4D Chart area

4D  Chart menu bar
4D  Chart zoom box
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The expanded window has a size box and close box. 

When the document window is expanded, the 

 

Go to Full Window

 

 
menu item in the File menu changes to 

 

Return to Form

 

.

����

❿❿❿❿

 

To reduce the window and return to the form:

 

1 Choose Return to Form from the File menu.
OR
Click the close box.

Creating a 4D Chart 
Area in a Form

 

You can add a chart area on an input form and save a chart with each 
record in the table.

For more information about inserting a plug-in area into a form, refer 
to the 

 

4th Dimension

 

 

 

Design Reference 

 

manual.

 

Hiding and 
Displaying 4D Chart 
Features

 

You can choose to hide or display several of 4D Chart’s features, 
including:

 

■

 

The 4D Chart menu bar

 

■

 

The Object Tool palette

 

■

 

The Chart Tool palette

 

■

 
Scroll bars

 

■

 
Rulers
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Use the 

 

Display

 

 submenu of the 

 

Edit

 

 menu of the plug-in area to hide 
or display these items. Items that are checked in the Display submenu 
are displayed in 4D Chart.

 

Note

 

If you have hidden the 4D Chart menu bar, you can display it by 

 

pressing 

 

Ctrl-Shift-M

 

 on Windows or

 

 Command-Shift-M

 

 on Macintosh.

 

Creating a New 
4D Chart Document

 

You can create a new, blank 4D Chart document at any time. The new 
document replaces the current document. If you have made changes to 
the current document, you will be prompted to save them before open-
ing a new document. ����

❿❿❿❿

 

To create a new document:

 

1 Choose New from the 4D Chart File menu.

 

An empty document appears in which you can create a new graph.
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Opening a 4D Chart 
Document

You can open any previously saved 4D Chart document in a 4D Chart 
area. The newly opened document replaces any current document. 

❿❿❿❿ To open a 4D Chart document:

1 Choose Open from the 4D Chart File menu.

A standard open-file dialog box appears. 

2 Select a document.

3 Click Open.
The document opens in the current 4D Chart window.

Note You can also open a PICT file in your chart. This point is covered in the 
paragraph “Importing a PICT document in a 4D Chart window,” 
page 219.

Saving a 4D Chart 
Document

You can save the contents of a 4D Chart document regardless of 
whether the document was created in a plug-in window or in a form. 
4D Chart offers several ways to save documents:

■ As a file

■ As part of a record

■ As a template for a 4D Chart area

You can also save a selection of objects, for instance a graph, as a PICT 
document (Macintosh format). In this case, the document saved is a 
picture that can no longer be modified. This point is covered in the 
paragraph “Exporting a 4D Chart document in PICT form,” page 220.
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Saving a 4D Chart 
Document as a File

Any document that you create using 4D Chart can be saved as a sepa-
rate document for use in another place — either in the same database, 
in another database that uses 4D Chart, or in an entirely different 
application. You use the standard Save and Save As menu items in the 
4D Chart File menu to save and update individual documents. 

Documents you save can be opened with the Open menu item in the 
4D Chart File menu. It makes no difference whether a document is 
created in a plug-in window or in a form; a document can be saved and 
opened in either place.

If you save a 4D Chart document as a file, when you reload the file, the 
document appears exactly as it was when you saved it. To update the 
information in any graphs in the document, you must use the Update 
menu item in the Chart menu, which is described in more detail in the 
section “Updating the Data in a Graph from the Database” on 
page 241.

❿❿❿❿ To save a 4D Chart document:

1 Choose Save As from the 4D Chart File menu.
Notice that you choose Save As from the 4D Chart File menu, not the 
4th Dimension File menu. 4D Chart displays a save-file dialog box.

2 Enter a filename for the document.

3 Click Save.
4D Chart saves the document with the filename you entered.

Saving a 4D Chart 
Document as Part of a 
Record

If you have created a 4D Chart area on a form and want its contents to 
be saved with each record, you need to create a BLOB or Picture field in 
the table to which the form belongs in order to store the contents of 
the area. The contents of the area are then saved automatically with 
each record when it is validated.
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For more information about creating 4D Chart areas on forms, refer to 
the 4th Dimension Design Reference manual.

❿❿❿❿ To save a 4D Chart document as part of a record:

1 Add a BLOB or Picture field to the table whose form contains the 
4D Chart area.
For more information about creating a field, refer to the 4th Dimension 
Design Reference manual.

2 Give the field the same name as the external area that you have 
created on the form and add an underline (_) to it.
For example, if your external area is named MyArea, the field must be 
named MyArea_.
Each chart is thus saved as a part of the record. 

If you save a 4D Chart document as part of a record, when you reload 
the record, the document appears exactly as it was when you saved it. 
To update the information in any graphs in the document, you must 
use the Update menu item, which is described in more detail in the 
section “Updating the Data in a Graph from the Database” on 
page 241.

Saving a 4D Chart 
Document as a Template

If you have inserted a 4D Chart area into a form, you can create a 
standard document that is the same for every record by saving the 
document as a template. You can create templates for 4D Chart only 
on forms. 

When you save a document as a template, the template is used for 
every new record that is opened in the form. 

Each document starts with the same template, but any unique modifi-
cations you make to it are saved with the record. There can be only one 
template for each 4D Chart area on a form.

If there is a graph in the document that is saved as a template, the 
graph is updated automatically for each record, if possible. 4D Chart 
can update a graph only if it was created from data stored in records in 
the database. 

❿❿❿❿ To save a document as a template:

1 Choose Save as Template from the 4D Chart File menu.
4D Chart saves the document with a special filename. The filename is 
the name of the 4D Chart area on the form, plus an underscore. 
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For example, an area named “Document” will have a template file 
named “Document_”.

Because 4D Chart automatically names the file and places it in the 
database directory; no save-file dialog box is displayed.

4D Server By default, 4D Chart templates are read from and saved to the client 
machines. You can use the 4D Chart language to specify that templates 
are read from and saved to the server machine. 

If you make changes to the document and want to incorporate those 
changes in the template, choose Save as Template again.

You can create a template for a 4D Chart area without using the 
Save as Template menu item simply by saving the document with a 
filename that is the same as the name of the 4D Chart area, plus an 
underscore, and placing the file in the database directory. This feature 
allows you, for example, to create a document in one database and use 
it as a template in another database. You can also create a document in 
one document area and use it as a template in another document area.

You can temporarily disable the use of a particular template file by 
changing the template filename or moving the file out of the database 
directory.

Importing a PICT 
document in a 
4D Chart window

You can open documents of the PICT type in a 4D Chart window. 
These documents can come from different sources (export of a 
4D Chart graph in PICT form, design software, etc.). The imported 
document behaves like a simple object; you cannot modify its 
attributes.

❿❿❿❿ To import a PICT document:

1 Choose the Import... command in the File menu of 4D Chart.
A standard open file dialog box appears. 

2 Select the PICT file you want to open (*.PCT extension under 
Windows) and click Open.
If the imported file is valid, its contents are displayed in the 4D Chart 
window.
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Exporting a 4D 
Chart document in 
PICT form

You can export a 4D Chart document or a selection of objects in it as a 
PICT file. In both cases, the objects do not keep their unique 4D Chart 
properties; the exported document is a static picture of the objects in 
the 4D Chart area or in the external window. You can import it as a 
PICT in 4D Chart or any other application that opens PICT files.

❿❿❿❿ To export a 4D Chart document in PICT form:

1 Choose the Export as... command in the File menu of 4D Chart.

2 Select a name and location for your file in the standard dialog box 
then click Save.

❿❿❿❿ To export a selection of 4D Chart objects in PICT form:

1 Select the object(s) that you want to export in PICT form.

2 Choose the Export Selection as... command in the File menu of 
4D Chart.
A standard save file dialog box appears. 

3 Select a name and location for the file and click Save. 
Whether you export a 4D Chart document or a selection of objects, a 
PICT file (*.PCT extension under Windows) is created on the disk.

Setting the 
Document Size

You can change the document size by changing the number of pages 
in the document or by specifying a new document size in points. The 
maximum drawing size is 3500 x 3500 points. You can add pages to the 
right of the first page, below it, or both.

❿❿❿❿ To change the document size:

1 Choose Properties from the 4D Chart Edit menu.
The Properties dialog box appears. The default document size is one 
page.

Click here to add or 
remove pages

Enter values here to 
set the drawing area 
to a specific size
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The document size is indicated by the point values to the right of the 
model document area and by the white rectangles in the model docu-
ment area. 

2 Click in the Document size area to adjust the number of pages in the 
drawing.
OR
Enter the exact size of the document (in points) in the Width and 
Height text areas.

Choosing a Graph Type
4D Chart allows you to create two-dimensional and three-dimensional 
graphs from within your database. Once you decide what data you 
want to graph, you should think about what type of graph will best 
display that data.

The nature of the data that you are graphing will help indicate the type 
of graph you should choose. For example, a line graph is best suited for 
showing how values (such as “number of units sold”) change over time. 

Don’t be afraid to experiment with different graph types. Once you 
have created a graph, you can easily convert it to another graph type. 
Creating graphs and changing their types are discussed in section 
“Creating a Graph” on page 234.

This section discusses the types of two- and three-dimensional graphs 
that you can create using 4D Chart. The features of each type of graph 
are described, along with the type of data that the graph is best suited 
to show.

Choosing a Two-
dimensional Graph 
Type

This section briefly describes the parts of a two-dimensional graph and 
then presents each two-dimensional graph type. 
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The following diagram shows a two-dimensional (two-axis) graph:

The X-axis is also called the Category axis. The X-axis displays the 
categories into which the information is divided. For instance, if you 
are graphing the number of computers sold per year, you would place 
the years on the X-axis.

The Z-axis is also called the Values axis. You use the Z-axis to display the 
values calculated for each category. In the computer sales example, the 
Z-axis would contain the values for the numbers of computers sold per 
year. For instance, if there were 500 computers sold in 1991, the Z-axis 
value corresponding to the X-axis category “1991” would be 500.

Another concept in graphing is the data series (or simply, series). Each 
category is composed of one or more series that further break down the 
information displayed in the graph. In this example, there was only 
one series, “computers sold.” Therefore, the series is not represented by 
a separate field or formula.

Sales History: Widget Computers

Graph values
on the Z-axis

Graph categories
on the X-axis
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However, suppose you want to compare the sales volumes from 1989 
to 1992 for three models of computers. In this case, each computer 
model becomes a distinct series on the graph. All series share the same 
categories (in this case, the years 1989 through 1992), but have their 
own values.

Another way to graph this data would be to create a three-dimensional 
graph of the data. This type of graph is discussed in the section 
“Choosing a Three-dimensional Graph Type” on page 229.

Area Graphs Area graphs are commonly used to show the magnitude of values over 
time, but can show values over any continuous category. 

Widget 100

Widget 350

Widget Pro

Sales History: Widget Computers (by model)
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The categories on the X-axis should be continuous, such as times or 
temperatures. Discrete categories, such as salespeople or products, are 
better suited to column graphs.

Options
The following options are available for Area graphs:

■ Stacked  When graphing multiple series, stack the areas for the series.

■ Stacked, proportional  When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal  Make the X-axis the vertical axis and the Z-axis the 
horizontal axis.

Column Graphs Column and bar graphs are the most frequently used graph types for 
business data. They are most frequently used to compare one item to 
another, or one or more items over a period of time.

The following column graph uses the Depth feature, which makes each 
column look three-dimensional. 

Note The Depth feature is discussed in more detail in the section “Modifying 
Depth in a Two-dimensional Graph” on page 264.

Stacked Stacked, proportional Horizontal
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Options
The following options are available for Column graphs:

■ Stacked  When graphing multiple series, stack the columns for the 
series in each category.

■ Stacked, proportional  When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal  Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. This option creates a bar graph. Bar graphs show the 
categories on the vertical axis, with the values expressed by the length 
of the bars. Bar graphs are often a useful alternative to column graphs, 
especially when the category labels are long.

■ Overlap  When graphing multiple series, use this option to specify the 
percentage by which the series columns within each category overlap 
each other.

■ Gap Width  Use this option to specify the spacial gap between the 
columns from one category to the next. The larger the gap, the 
narrower the columns for each category.

Line and/or Scatter 
Graphs

Line graphs are often used to show the rate of change of values over 
time. Scatter graphs can show relationships and trends in your data. 
Such graphs are most often used when there are a large number of 
different values of the X-axis field, as in a scientific study. 
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The values on the X-axis should be continuous or ordered, such as 
times or temperatures. Discrete categories or categories that do not 
have an order — such as salespeople or products — are better suited to 
column graphs.

Options
The following options are available for Line and/or Scatter graphs:

■ Stacked  When graphing multiple series, stack the lines for the series in 
each category.

■ Horizontal  Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. 

■ Displaying lines and/or points
You can:

■ Show Points  Each value appears as a dot in the graph.

■ Show Lines  Only lines appear in the graph.

■ Show Both  Lines and Points appear in the graph.

Pie Charts Pie charts show data as a percentage of a whole. Your data does not 
need to be expressed as percentages; 4D Chart automatically converts 
the data into percentages when it creates the pie chart.

Each pie chart can have only one series. Categories are displayed in the 
legend.

France Leads Widget Market

France

England

USA40.0%

30.9%

29.1%
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Options
The following option is available for pie charts: 

■ Start Angle  Use this option to specify the rotation of the chart. The 
specified angle determines the placement of the first edge of the first 
category in the chart.

Picture Graphs Picture graphs are similar to column graphs, except that you can 
substitute a picture for the column.

Options
The following options are available for Picture graphs in 4D Chart: 

■ Stacked  When graphing multiple series, stack the pictures for the 
series in each category.

■ Stacked, proportional  When graphing multiple, stacked series, show 
the series as proportions of a 100% whole.

■ Horizontal  Make the X-axis the vertical axis and the Z-axis the 
horizontal axis. This option creates a bar picture graph.
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■ Overlap  When graphing multiple series, use this option to specify the 
percentage by which the series within each category overlap.

■ Gap Width  Use this option to specify the spacial gap between the 
picture columns from one category to the next. The larger the gap, the 
narrower the picture columns.

Additional options for aligning and adjusting the pictures are discussed 
in the section “Adding Pictures to a Picture Chart” on page 273.

2D XY Graphs 
(Scatterplots

Each data point in a scatterplot represents a pair of values. The X-axis 
is also a value axis.

When the 2D XY type is selected, the option Category is replaced with 
Values (X) in the Chart>Axis, Chart>Grid Lines and Chart>Titles 
menus. 

Options
The following options are available for 2D XY graphs in 4D Chart: 

■ Plots shapes  You can display None, Circles, Squares, or Star plots.

■ Lines appearance  You can display None, Straight, or Arrows lines.

■ Show Regression Line  (y = ax+b)  Allows to view the predictive 
relation between the X- and Y-axis values (if appropriate). 
There is one regression line for each series of points. Using Ctrl+click 
(Windows) or Command+click (MacOS), you can select the points 
associated with the regression line.

■ 2D XY variant: Polar charts
Polar charts are used to show the distribution of data around a central 
point. In a polar chart, each point is plotted in terms of degrees from 
the zero point and distance from the center. 
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Each data point on a polar chart is plotted using one Z-axis field to 
specify the angle in degrees and a second Z-axis field to specify the 
distance from the center.

Choosing a Three-
dimensional Graph 
Type

This section briefly describes the parts of a three-dimensional graph 
and then presents each three-dimensional graph type. 

The following diagram shows a three-dimensional (three-axis) graph:

Distribution of Dairies Around 

Distance in Miles

Acme Milk Processing Plant

Graph values
on the Z- axis

Graph categories
on the X-axis

Graph series
on the Y-axis
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As with a two-dimensional graph, the X-axis (or, Category axis) dis-
plays the categories into which the information is divided. For 
instance, if you are graphing the number of computers sold per year, 
you would place the years on the X-axis.

In a three-dimensional graph, the Y-axis is also called the Series axis. 
Each category is composed of one or more series that further break 
down the information for each value of the X-axis field. Each data 
point in the graph is the intersection of one category and one series. In 
the example illustrated above, each computer model is a series. 

In a two-dimensional graph, the series remain on the X-axis. The col-
umns representing each series are distinguished by their patterns. In a 
three-dimensional graph, the series are displayed on their own axis. 
Each series still has its own pattern, but now the series are also sepa-
rated from each other in space.

The Z-axis displays the values calculated for each combination of 
category and series. 

In the computer sales example, the Z-axis would contain the values for 
the numbers of each type of computer sold per year. For instance, if 
there were 725 Widget Pro computers sold in 1991, the Z-axis value 
corresponding to the X-axis category “1991” and the Y-axis series 
“Widget Pro” would be 725.

 

3D Column Graphs

 

3D Column graphs, like 2D Column graphs, compare one item to 
another, or one or more items over a period of time.

 

Improvement in Test Scores
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Options

 

The following options are available for 3D Column graphs:

 

■

 

Category Gap/Width

 

  The gap between or width of the categories in 
the graph. The larger the category gap, the smaller the category width.

 

■

 

Series Gap/Width

 

  The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

■

 

Tops only

 

  Show only the top side of each column.

 

3D Line Graphs

 

3D Line graphs show trends in your data. They should be used for 
continuous categories, such as time.

 

Option

 

The following option is available for 3D Line graphs:

 

■

 

Series Gap/Width

 

  The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

1990 1995 2000 2005
Imports

Exports

Trends in Widget Imports and Exports
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3D Area Graphs

 

3D Area graphs emphasize the volume or size of the series over a 
continuous category, such as time.

 

Option

 

The following option is available for 3D Area graphs:

 

■

 

Series Gap/Width

 

  The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

3D Surface Graphs

 

Surface graphs show three-dimensional data where the Z-axis value 
varies depending on the X- and Y-axis values. Surface graphs are 
commonly used to graph the results of mathematical formulas.

The following graph was created using a mathematical formula.
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Option

 

The following option is available for 3D Surface graphs:

 

■

 

Tops only

 

  Show only the top side of the surface, not the sides. This 
option is used in the previous example graph.

Here is an example of a surface graph with sides.

 

3D Triangle Graphs

 

3D Triangle graphs compare one item to another, or one or more items 
over a period of time. 3D Triangle graphs are an alternative to 
3D Column graphs.

 

Options

 

The following options are available for 3D Triangle graphs:

 

■

 

Series Gap/Width

 

  The gap between or width of the series in the graph. 
The larger the series gap, the smaller the series width.

 

■

 

Flipped

 

  The triangles appear flipped vertically.

 

■

 

Plot Zero Values

 

  If this option is not selected, zero values will be 
omitted from the graph.
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3D Spike Graphs

 

3D Spike graphs show the intersection of three values. Each data point 
is connected to the Category plane with a drop line.

 

Option

 

The following option is available for 3D Spike graphs:

 

■

 

Oval/Square Heads

 

  Use this option to specify whether the spike heads 
are oval or square.

 

Creating a Graph

 

This section includes the basic steps for creating a graph. After reading 
this section, you will be able to:

 

■

 

Create a two-dimensional or three-dimensional graph from data stored 
in the database or copied to the Clipboard

 

■

 

Update a graph created from data in the database

 

■

 

Change a graph’s type

 

■

 

Change the options specific to each graph type

4D Chart allows you to create two-dimensional and three-dimensional 
graphs based on the data in fields in your database. You can graph the 
values in the fields themselves, or you can graph the values that result 
from formulas that use the fields.
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Whatever the case, when you create a graph, you select the data that 
you want to graph on each axis. For each axis, there are certain restric-
tions on the data types that can be graphed. If a data type cannot be 
graphed on a certain axis, fields of that type cannot be selected in the 
Chart Wizard. The following table provides information on the types 
of data that can be assigned to the Categories or Series axis and the Val-
ues axes.

 

Creating a Selection 
of Records to Graph

 

Before you begin the process of creating a graph, you must create a 
selection of records to graph.

4D Chart can operate in its own window or in 4D Chart areas on forms. 
The following sections explain how to generate the selection of records 
to be graphed, depending on the 4D Chart location. 

 

Creating a Selection of 
Records in a Plug-in 
Window

 

4D Chart graphs the records in the current selection. Before you create 
a graph in a plug-in window, select the records you want to graph. 

4D Chart will not create a graph unless there is at least one record in 
the current selection of the table whose data you want to graph. 

 

Creating a Selection of 
Records in an Input 
Form

 

A 4D Chart area in an input form can be used to graph data in other 
tables. 

The table whose records you want to graph must have at least one record 
in its current selection. If the table that contains the form is automati-
cally related to the table you wish to graph, the current record in the 
input form determines the selection of records in the related table.

 

Data Type
Category or 
Series Axis?

Values
Axis?

Compatible Types
on Values Axis

 

Alphanumeric Yes No -------

Text Yes No -------

Real Yes Yes Integer, Long integer

Integer Yes Yes Real, Long integer

Long integer Yes Yes Real, Integer

Date Yes Yes -------

Time Yes No -------

Boolean Yes No -------

Picture No No -------

Blob No No -------
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Because you have a record loaded in an input form, you should avoid 
creating graphs from data in the current table. If you want to graph 
data from the same table as the input form, you must use 

 

PUSH RECORD

 

 and 

 

POP RECORD

 

 or create a new process with the 

 

New process

 

 function. For more information, see the descriptions of 
these commands in the 

 

4

 

th

 

 

 

Dimension Language Reference

 

.

For more information about adding a 4D Chart area to a form, see the 

 

4

 

th

 

 

 

Dimension Design Reference

 

.

 

Creating a Graph 
From Data in the 
Database

 

For a two-dimensional graph, you specify a field for the horizontal axis 
(X-axis) and one or more fields or formulas for the vertical axis 
(referred to in 4D Chart as the Z-axis). 

For a three-dimensional graph, you will specify one field (or formula) 
each for the X-, Y-, and Z-axes.

The following example graph shows how 4D Chart uses the informa-
tion in the database to create a 2D graph. The graph plots the scores on 
two tests for each of 11 students. The X-axis field is Student ID, and the 
Z-axis fields are AOC Score and TUC Score.

Name of 1st
Z-axis field

Name of 2nd
Z-axis field

Value stored in
AOC Score field
for Student #6

Categories stored 
in X-axis field

Scale values
generated by
4D  Chart from
Z-axis values

Test Scores for Fifth Grade
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The following example graph shows how 4D Chart uses the informa-
tion in the database to create a graph. The graph shows the average 
monthly stock value for two companies. The X-, Y-, and Z-axis fields 
are, respectively: Month, Company Name, and Average Price.

����

❿❿❿❿

 

To create a graph from data stored in the database:

 

1 Make sure that no graph is currently selected in the 4D Chart area.

 
To deselect a selected graph, click anywhere in the 4D Chart area 
outside the graph. 

2 Click the Graph icon  in the Chart Tool palette.
OR
Choose New Chart from the Chart menu.

Series stored in
the Y-axis field

Z-axis field 
for Ink, Inc. in

Categories stored 
in the X-axis field

Scale values
generated by
4D  Chart from
Z-axis values February

Value stored in
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The Chart Wizard appears. 

The Chart Wizard has three pages:

 

■

 

Chart Type

 

  displays the 12 chart types supported by 4D Chart and 
lets you choose a graph type.

 

■

 

Chart Style

 

  displays the variations on the type of graph that you 
selected in the Chart Type page. The Chart Style page changes 
depending on your choice of chart type.

 

■

 

Data Selection

 

  lets you select the table that contains the data you 
wish to graph and a field list. Use the Data Selection page to assign 
fields or formulas to the graph axes. The Data Selection page 
changes depending on the graph type you chose.

You must choose a chart type and use the Data Selection page to assign 
appropriate fields or formulas to each axis that the chart type requires. 
You do not need to choose a chart style.

 

Note

 

If you are creating a graph in a 4D Chart area in an input form, the 
current table is not listed in the Tables list because you cannot graph 

 

data from the current table.

 

3 Click a chart type.

 

When you click on a chart type, the Chart Style and Data Selection 
pages change to match the requirements of the selected type. For com-
plete information on the types of charts available in 4D Chart, see 
“Choosing a Graph Type” on page 221.
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4 Click the Chart Style tab (Optional).

 

The styles for the selected chart type appear. The following illustration 
shows the styles available for the 2D Column chart type.

 

5 Click the desired chart style.

6 Click the Data Selection tab.

 

The Data Selection page appears, displaying the appropriate options 
for the selected chart type.

Table drop-down list

2D graph

Fields list
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7 Choose the desired table from the Table drop-down list.

 

The Fields list changes to show the fields from the selected table.

 

8 Drag the field that you want to assign to the Category axis to the 
Category box or double-click the field.

 

Note

 

If you make a mistake when choosing the X-axis field, replace the field 

 

by dragging the desired to field to Category box.

 

■

 

If you want to create a three-dimensional graph, you must fill the 
“Second Category (Y Axis)” area. Go to the following step.

 

■

 

If you want to create a two-dimensional graph, you only need to fill 
the “Values (Z Axis)” area. Go to step 10.

 

9 If you are creating a 3D graph, drag the Series field to the Y-axis 
(Second Category) box or double-click the field.

 

The name of the field appears in the Y-axis box.

 

Note

 

If you make a mistake when choosing the Y-axis field, replace it by 

 

dragging the correct field to the Second Category box.

 

3D graph
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10 Drag the field containing the values to be graphed to the Values (Z-
axis) box or double-click the field

 

1

 

.
OR
Click the Formula button (2D graphs only).

 

The name of the field or the formula appears in the Z-axis (Values) box.
For instructions on creating a formula, see the section “Adding a 
Formula” on page 246.

 

11 If you want to have the Z-axis values summed for each X-axis category, 
click the Group check box.

 

This option is used when the X-axis categories are not unique and you 
want each category to appear only once, with the values for each 
instance summed. For more information about this option, see the 
section “Grouping Non-unique Categories and Series” on page 245. 

12 If you want to have the Z-axis values summed for each Y-axis series, 
click the Group check box (3D graphs only).

 

This option is used when the Y-axis series are not unique and you want 
each series to appear only once, with the values for each instance 
summed. For more information about this option, see the section 
“Grouping Non-unique Categories and Series” on page 245.

 

13 When you have finished designing your graph, click OK.

 

4D Chart creates the graph and displays it in the 4D Chart area.

 

Updating the Data in a 
Graph from the 
Database

 

When you create a graph from data stored in the database, the data in 
the graph is static. Although the data in the database may change, the 
data in the graph remains the same until you update it. 

You can tell 4D Chart to update a graph by choosing 

 

Update

 

 from the 

 

Chart

 

 menu. When you choose Update, 4D Chart regenerates the 
selected graph using the data in the current selection for the table 
whose fields you are graphing. 

You will want to update a graph in the following situations:

 

■

 

When you want to include more records in the selection

 

■

 

When you want to include fewer records in the selection

 

■

 

When you want to include different records in the selection

 

1. With 2D graphs, you can add more than one field or formula to the Z-axis. 
Each field or formula becomes a series. For more information, please refer to 
the section “Choosing a Graph Type” on page 221. 
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■

 

When the data in the selection has been modified.

When you use 

 

Update

 

, 4D Chart recreates the graph using the new 
current selection and the settings you chose for the original graph. 

 

Note

 

The 

 

Update

 

 menu item is available only for graphs created from data 

 

in the database.

 

Creating a Graph 
From Data on the 
Clipboard

 

You can graph data from any application if it is correctly formatted and 
then copied to the Clipboard. This section describes how to format 
data in order to use it in a graph, and how to create a 4D Chart graph 
from this information.

 Formatting Data and 
Copying It to the 
Clipboard

 You can graph data that is formatted in the Tab-Tab-Return (TTR) 
format. If you copy cells from any spreadsheet application, they will be 
in TTR format. You can also use data from a word-processing 
application if it is formatted with tabs between the fields and carriage 
returns between the records.

Following are examples of correctly formatted data:

 

Note

 

The and symbols represent the invisible symbols used by many 
word-processing applications to indicate tabs and carriage returns, 

 

respectively.

The first row of data is used as the field names. Each column contains 
the data for one field.

 

Note

 

If you want to use dates copied to the Clipboard, the dates must be in 

 

the same format as the System-level date format.

When you have prepared the data in your application, select the 
desired rows and columns and copy them to the Clipboard. 

TTR data (word-processing) Spreadsheet data

Names
Helen 25

Todd 27

Norm 22

Michele 23

Ages Names
Helen

Todd
Norm

Michele

25

27
22

23

Ages
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Creating the Graph from 
Data on the Clipboard

 

For a two-dimensional graph, you will specify a field for the X-axis and 
one or more fields or formulas for the Z-axis. The following illustration 
shows how 4D Chart interprets the information from the Clipboard.

For a three-dimensional graph, you specify one field each for the X-,
Y-, and Z-axes. The following illustration shows the spreadsheet data 
used for the example graph. The information details the total sales by 
two different stores to three types of customers. 

Names
Helen

Mike

Norm
Michele

25

27

22
23

AgesField names

Records

Clipboard

 

Name of the
Z-axis field

Norm’s age

Values stored in 
the X-axis field

Scale values
generated by
4D  Chart from
Z-axis values

 

2D Graph

Field names

Records

Categories
Series
Values

Clipboard
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❿❿❿❿

 

To create a graph from data stored on the Clipboard:

 1 Copy the data to be graphed to the Clipboard, using the format 
described in this section.

2 Follow the instructions provided in steps 1 to 6 in the section 
“Creating a Graph From Data in the Database” on page 236.

 

The Data Selection page appears, configured for the selected chart type.

 

3 Click the Use Data From Clipboard check box.

Series

Categories 

Total value of
sales to retail stores
at the Sunny Valley
store location

3D Graph
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Clicking Use Data From Clipboard disables the Source Table drop-
down list and populates the Fields list with the field names from the 
Clipboard, as shown below.

 

4 Assign fields to the axes by dragging to the appropriate areas or by 
double-clicking the fields.

 

When all areas have been assigned fields, the 

 

OK

 

 button is enabled.

 

Note

 

With 2D graphs, you can add as many fields and formulas to the Z-axis 
as you like. However, be sure to choose only numeric fields. Do not 
mix date fields and formulas with number fields and formulas. Each 

 

item in the Z-axis (Values) box becomes is plotted in the graph.

 

5 If you want to have the Z-axis values summed for each X-axis category, 
click the Group check box.

 

This option is used when the X-axis categories are not unique and you 
want each category to appear only once, with the values for each 
instance summed. For more information about this option, see the 
section “Grouping Non-unique Categories and Series” on page 245.

 

6 When you have finished designing your graph, click OK.

 

4D Chart creates your graph and displays it in the 4D Chart area.

 

Grouping Non-
unique Categories 
and Series

 

Some categories or series may appear more than once in your data. For 
instance, suppose that you want to graph the total purchases made by 
each of your customers. Each customer may have made several 
purchases.

 

Disabled Source Table 
drop-down list

Field list from 
Clipboard
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When you create a two-dimensional graph, you can choose to sum the 
values for non-unique categories, so that each category appears only 
once on the graph. When you create a three-dimensional graph, you 
can choose to sum the values for non-unique categories, non-unique 
series, or both.

To create the graph described in the example above, you might graph 
from the [Invoices] table, using [Invoices]Customer for the X-axis 
categories and [Invoices]SalesTotal for the Z-axis values. Because some 
customers may have more than one invoice, you would want 4D Chart 
to sum the values in the [Invoices]SalesTotal field so that there would 
be only one value (the total) for each customer.

The illustrations below show the same basic graph with and without 
the Group

 

 

 

option:

To group data on the Category or Series axis, check the corresponding 

 

Group

 

 

 

check box in the Data Selection page of the Chart Wizard.

 

Adding a Formula 

 

You can graph values that are not represented in your data but are 
obtained by performing calculations on the data or on other values in 
your database. For example, you can graph your profits by graphing the 
results of a formula that subtracts your unit cost from your retail price.

You can refer to any valid 4

 

th

 

 Dimension method and graph the result 
on the Values axis. The method must return a value to 4D Chart. If the 
categories are grouped, 4D Chart sums the values returned.

 

Graph without
Group option

Graph with
Group option
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If there are fields or other formulas also being graphed on the Values 
axis, the data types of all the values must be compatible. For instance, 
if you are graphing a Date field and a formula on the Values axis, the 
formula must return a date. 

 

Formulas are available only for two-dimensional graphs.

����

❿❿❿❿

 

To use a formula to calculate values for a graph:

 

1 When you are ready to specify the Values field in the Data Selection 
page, click the Formula button.

 

The 4D Formula dialog box appears.

 

2 Type the formula.

 

For more information about the Formula Editor dialog box, please refer 
to section “The Formula Editor” on page 113. Following are some 
examples of formulas: 

3 Click OK.

4 When you have finished designing the graph, click OK in the Chart 
Wizard to create the graph.

 

Changing the Graph 
Type

 

You can switch between graph types at any time. You can change from 
one two-dimensional graph type to another or from one 
three-dimensional graph type to another. When creating a graph, feel 
free to experiment with graph types to find the best way to present 
your data.

����

❿❿❿❿

 

To change the graph type:

 

1 Make sure that the graph is selected.

 

You select a graph by clicking it. When a graph is selected, selection 
handles appear around it.

 

Formula Syntax

 

Month of (Current date) 4D function (4D function)

Day of ([Invoices]Invoice date) 4D function (field)

Sin (vX) 4D function (variable)

NumVisits Method that returns a value in $0
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2 Choose another graph type from the Graph  drop-down list in 
the Chart Tool palette.
OR
Choose the Chart Type item in the Chart menu.

 

The “Choose a Chart Type” window is then displayed. You can select 
another chart type and click 

 

OK

 

. 

The graph is redrawn using the new graph type. Both the Graph drop-
down list and the Choose a Chart Type window display only the chart 
types that are appropriate for the selection of data. You cannot, for 
example, plot 3D data using a 2D graph type. For information on the 
graph types available in 4D Chart, see the section “Choosing a Graph 
Type” on page 221.

 

Setting the Graph Type 
Change Alert 

 

You can have 4D Chart display an alert dialog box when the user 
attempts to change the type of a graph. The user then has the option 
to cancel or continue with the change.����

❿❿❿❿

 

To display an alert dialog box when a new graph type is selected:

 

1 Choose Properties from the 4D Chart Edit menu.

 

The Properties dialog box appears. 

 

2 Check or uncheck the Chart Type Change Alert check box.

3 Click OK to close the Properties dialog box.

 

Changing the 
Options for a Graph 
Type

 

Each graph type has a particular set of options that you can change 
using the Options dialog box. By changing the graph options, you can, 
for example, change a column graph to a bar graph, or show the series 
in an area graph as proportions of a whole.

Chart type change 
alert check box
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����

❿❿❿❿

 

To open the Options dialog box for a graph:

 

■

 

Double-click the graph.
OR
Select the graph and choose Options from the Chart menu.

 

For more information about the options for each graph type, see section 
“Choosing a Graph Type” on page 221.

 

Modifying Graph Features

 

This section explains how to modify graph features. After reading this 
section, you will know how to:

 

■

 

Resize a graph

 

■

 
Customize graph axes

 

■

 
Show and hide grid lines

 

■

 

Display the series values

 

■

 

Customize legends

 

■

 

Add depth to a two-dimensional graph

 

■

 

Change the perspective of a three-dimensional graph

 

■

 

Customize the tips of a chart

 

■

 

Change the graphic attributes of chart objects

 

■

 

“Explode” a wedge from a pie chart

 

■

 

Add a picture to a picture chart

 

Resizing a Graph

 

You can resize a graph by dragging its selection handles. Selection 
handles are the black squares that appear around the object when it is 
selected. 

You can resize the height and width at the same time, maintaining the 
sizing proportion between the two. 

����

❿❿❿❿

 

To resize a graph:

 

1 Select the graph.

2 Hold down the mouse button on a selection handle and drag it up, 
down, or diagonally.
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If you drag a corner, the height and width change. If you drag a side, 
either the height or the width changes.

To resize the object so that the height and width retain the same 
proportion to each other, hold down the 

 

Shift

 

 key while you are 
resizing.

 

3 Release the mouse button when you have finished.

 

The graph is resized.

 

Customizing the 
Axes

 

You can customize many aspects of each axis of a graph. This section 
contains information about:

 

■

 

Customizing the axis labels

 

■

 

Customizing the tick marks

 

■

 

Changing the scale of the Values axis

 

■

 

Reversing the order of data points on an axis

 

■

 

Positioning the origin

 

■

 

Adding axis titles

The following table explains the axes available in two-dimensional 
(2D) and three-dimensional (3D) graphs:

 

Dragging a 
selection handle

 

Number of Axes Axis Name Axis 

 

Two (2D Graph) Category X
Series N/A
Values Z
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You can display the Axis dialog box for any axis by choosing the 
appropriate axis from the 

 

Axis

 

 submenu of the 

 

Chart

 

 menu.

Using the Axis dialog box, you can change the location of the axis 
labels, tick marks, and origin. You can also change the scale used for 
the Values axis and reverse the order of the items graphed on each axis.

This section presents the dialog boxes that you use to customize the 
axes of your graph. It then provides details about each of the options.

The Category Axis dialog box enables you to customize the Category and 
Series axes:

 

Note

 

The Tick Marks drop-down list, Reverse Order check box, and Cross 
Axis At text box are not available in the Category or Series Axis dialog 

 

box for three-dimensional graphs.

 

Three (3D Graph) Category X
Series Y
Values Z

 

Number of Axes Axis Name Axis 

Labels area

Tick marks drop-down list
Reverse order check box

Cross Axis at box

Show One Label out of box
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The following dialog box enables you to customize the Values axis:

 Note  Only the Labels and Scale areas are available in the Axis dialog box for 
three-dimensional graphs. The Date Increment drop-down lists are 

 

available only when dates are being graphed on the Values axis.

 

Customizing the Axis 
Labels

 

4D Chart automatically labels the axes when it generates a graph. You 
can change the position, orientation, and format of the labels, or you 
can decide not to display them with your graph.

 

■

 

Label Positions

 

You can choose one of the following label positions from the 

 

Position 
drop-down list:

■ None

■ Top

■ Bottom

■ Left

■ Right

Depending on the orientation of the axis, either Top and Bottom or 
Left and Right will be unavailable.

When the position is None, the label does not appear on the graph. 

Tick Marks area

Labels area
Scale

Z-axis Crosses at 
Category box

Logarithmic 
check box

Reverse Value 
Order check box

area
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■ Label Orientation
The following label orientations are available for each axis:

■ Label Formats
You can change the way data in your labels is displayed by using 
display formats. For instance, you can use a display format to display 
dollar amounts using the dollar sign ($), commas, and decimals. 

The following table shows some examples of the effects of display 
formats:

When you select one of the formats from the Format drop-down list, it is 
entered into the Format text box, located to the right of the drop-down 
list. If you want to use a custom format, you can enter it in that area.

You can use one of 4th Dimension’s built-in formats, edit a format, or 
create one of your own. For more information, see the 
4th Dimension Design Reference manual.

■ Labeling Data from Boolean Fields
If you create graphs using Boolean fields from the database, the default 
axis labels are “0” and “1”, corresponding to FALSE and TRUE. You can 
label your graph more informatively by changing the label format. 

To create more meaningful labels for Boolean fields, change the label 
format to the following:

TrueLabel;;FalseLabel

For example, you might change the format to “Female;;Male” or 
“Experimental;;Control”.

Orientation

Normal Vertical Rotated 
Left

Rotated 
Right Staggered Wrap

R
e
s
u
l
t

Label L
a
b
e
l

La
be

l Label

Label1 Label3
Label2

Lab
el

Data in Default Format Display Format Data in Display Format
3400 $###,###.00 $3,400.00
3/4/99 Month Date, Year March 4, 1999
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Reducing the Number of 
Labels

You can reduce the number of labels displayed on the X-axis or Y-axis 
of a graph. This feature is useful when you create graphs with a large 
number of categories (more than 100).

When this option is used, 4D Chart displays only one label per N labels 
on the selected axis. To use this option, enter a value between 2 and 
255 in the “Show One Label out of” box. For example, if you enter 10, 
4D Chart will display one label per 10 categories. The value 1 is the 
standard setting (all labels are displayed).

■ Auto: if you check the Auto box, 4D Chart will calculate the appropri-
ate number of labels to display, according to the amount of room.

Customizing the Tick 
Marks

Tick marks show the increments of the axes. You can choose among 
different styles of tick marks, or you can decide not to show the tick 
marks. You can customize this option for each axis in a two-
dimensional graph.

Note You cannot customize the tick marks for a three-dimensional graph.

The following tick mark styles are available:

■ Cross ( )

■ Inside ( )

■ Outside ( )

Changing the Values 
Axis Scale

You can change the minimum and maximum values shown on the 
Values axis. You can also change the major and minor units of the axis. 

If dates are being graphed, you can specify whether the major and 
minor units are measured in days, weeks, months, or years.

In addition, you can specify that the graph use the default value for 
any of these items. To use the default value, simply check the check 
box located to the left of the desired option.
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In the following graphic, the default minimum and maximum values 
and the user-specified major and minor units are used.

■ Using a Logarithmic Scale
You can change the scale from normal to logarithmic by checking the 
Logarithmic check box, located in the Values axis dialog box.

Reversing the Order of 
the Data 

You can reverse the order of the data on an axis by checking the 
Reverse Order check box. You can reverse the order of data only in a 
two-dimensional graph.

Positioning the Origin You can change the position of the origin — the place where one axis 
crosses another — for each axis in a two-dimensional graph.

■ Changing the Origin of the Values (Y) Axis
The origin of the Z-axis is the value at which the Category (X) axis 
crosses the Z-axis. Usually, the origin is the minimum value on the 
graph or zero. Sometimes, you will want to change the position of the 
origin.

❿❿❿❿ To change the origin of the Values axis:

1 Choose Category (X) from the Axis submenu of the Chart menu.
The Category (X) dialog box appears.

2 Enter a value in the “Cross Axis At” text box.
The value you enter is the numerical value of the desired origin 
position.

3 Click OK to close the dialog box.

■ Changing the Origin of the Category (X) Axis
The origin of the X-axis is the category at which the Values axis crosses 
the X-axis. Usually, the origin is placed to the left of the first category. 
Sometimes, you will want to move the origin.

Scale area

Date increment 
drop-down list
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❿❿❿❿ To change the origin of the Category (X) axis:

1 Choose Values (Z) from the Axis submenu of the Chart menu.
The Values (Z) dialog box appears.

2 Enter a number in the “Z-Axis Cross at Category” text box.
The number you enter is the number of the category at which the 
origin should cross. The categories are numbered from left to right, (or 
from bottom to top in a horizontal chart). The Z-axis crosses to the left 
of the specified category.

To move the origin to the right of the last category on the graph, 
specify the number of categories plus 1. 

If the specified number is higher than the number of categories plus 1, 
the value is ignored and the origin is reset to the left of the first 
category.

3 Click OK to close the dialog box.

Adding Axis Titles You can add a title for each axis. Usually, the titles describe the data 
graphed on the axis.

❿❿❿❿ To add a title to any axis:

1 Choose the appropriate axis from the Titles submenu of the Chart 
menu.
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The Titles dialog box appears.

2 Type the title into the “Title” text box.

3 Choose a position for the title from the “Position” drop-down list.
This specifies the position of the title relative to the graph. 

You can choose one of the following title positions:

■ None

■ Top

■ Bottom

■ Left

■ Right

The default position is None. When the position is None, the title does 
not appear on the graph. 

Depending on the orientation of the axis, either Top and Bottom or 
Left and Right will be unavailable.

4 Choose an orientation for the title from the “Orientation” drop-down 
list.
The following orientations are available for each axis:

■ Normal

■ Vertical

■ Rotated Left

■ Rotated Right

5 Click OK.

Showing and Hiding 
Grid Lines

You can display grid lines for the major and minor increments of each 
axis. Grid lines can make a graph easier to read.

The major and minor increments are set in the Axis dialog box for the 
Values axis.

Title text box
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❿❿❿❿ To display the grid lines for any axis:

1 Choose the appropriate axis from the Grid Lines submenu of the Chart 
menu.

The Grid Lines dialog box appears.

2 Click the desired check boxes and click OK.

Displaying the 
Series Values

You can display information for each series directly in the graph. You 
can display the following information:

■ Values  The actual number or date, in Arabic numerals. You can show 
the values on the graph instead of using labels on the Values axis, or 
use them to supplement the axis labels.

■ Percentages  The value of the data point divided by the sum of all the 
values in the category, as a percentage.

■ Categories  The name of the category, identical to the axis label for the 
category.
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The following graph shows the values at the tops of the columns.

You can select the location at which the values, percentages, or 
category labels should appear, their orientation, and their format. 

This feature is not available for three-dimensional graphs.

❿❿❿❿ To display information about the data in a series:

1 Choose Values from the Chart menu.
The Values dialog box appears.
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2 Select the location at which the information should appear. 
You can select one of the following options from the Position drop-
down list:

3 Select the type of information you wish to display.
You can select one of the following options from the Display drop-
down list:

■ Values

■ Percentage

■ Category

■ Value & Percent

■ Categories & Percent

4 If you wish, select a format from the “Format” drop-down list.
You can change the way values are displayed by using display formats. 
For instance, you can use a display format to display dollar amounts 
using the dollar sign ($), commas, and decimals. 

The following table shows some examples of the effects of display 
formats:

When you select one of the formats from the Format drop-down list, it 
is entered into the Format text box, located below the drop-down list.

You can use one of 4th Dimension’s built-in formats, edit a format, or 
create one of your own. For more information, see the 4th Dimension 
Design Reference manual.

Pie Charts All Other Graph Types 
None None
Inside Outside Top
Outside Outside Bottom

Inside Top
Inside Centered
Inside Bottom
At Axis

Data in Default Format Display Format Data in Display Format

3400 $###,##.00 $3,400.00

3/4/99 Month Date, Year March 4, 1999
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5 Select an orientation from the “Orientation” drop-down list.
You can select one of the following options:

■ Normal

■ Vertical

■ Rotated Left

■ Rotated Right

6 When you are finished making your selections, click OK.

Customizing the 
Legend

4D Chart automatically creates a legend for you when it generates the 
graph. By default, the legend is based on value labels. You can 
customize the legend’s location, order, and text.

Displaying and Hiding 
the Legend

To display or hide the legend for the selected chart:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Click the Display Legend check box.
If this check box is checked, the legend is displayed as part of the chart 
object. If this check box is unchecked, the legend is hidden.

3 Click OK to close the dialog box.

The next section explains how to position the legend in the chart 
object.

Display Legend 
check box
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Positioning the Legend The legend is part of the chart object. You can position the legend 
using the eight built-in legend locations, or you can move it using the 
mouse. You can move the legend anywhere in the document, includ-
ing placing it inside the graph itself. 

In addition, you can display the legend vertically or horizontally. In 
other words, the series in the legend can be placed left-to-right or 
top-to-bottom.

Positioning the Legend 
Using the Built-in 
Locations

To use the built-in locations for the legend:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Select a legend position by clicking one of the model legends in the 
Location area.
The location you choose will determines whether the orientation is 
horizontal or vertical.

3 Click OK to close the dialog box.

Positioning the Legend 
with the Mouse

You can position the legend anywhere in the 4D Chart document by 
moving it with the mouse.

❿❿❿❿ To position the legend with the mouse:

1 Hold down the Ctrl key (qqqq key on Macintosh) and click the legend to 
select it.

Horizontal orientation

Vertical orientation



Modifying Graph Features

2634th Dimension User Reference

2 While continuing to hold down the Ctrl or qqqq key, click and drag the 
legend to the desired location.

3 Release the mouse button and the Ctrl or qqqq key.

Maintaining the Legend 
Location

When you use the Legend dialog box, click the User Specified button 
to maintain the legend location. If you select one of the built-in 
locations, the User Specified option is automatically deselected.

Setting the Legend 
Order

You can reverse the order of the series in the legend. In addition, you 
can reverse the order of the legend key and legend text.

❿❿❿❿ To change these options:

1 Choose Legend from the Chart menu.
The Legend dialog box appears. The following options are available:

■ Reverse Legend Order  Reverses the order of the series in the leg-
end.

■ Reverse Key and Text  If this check box is checked, the square con-
taining the color or pattern code for each series is displayed after 
the series name.

2 Check or uncheck the check boxes as desired.

3 Click OK to close the dialog box.

Customizing the Legend 
Text

You can customize the text of any or all of the series in a legend. 

❿❿❿❿ To customize legend text:

1 Choose Legend from the Chart menu.
The Legend dialog box appears.

2 Click the Legend Titles tab.
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The Legend Titles page appears.

The series labels for the legend are displayed in a list. 

3 Choose the series label to edit by clicking its name in the list.
The series label is highlighted in the list and the text of the label 
appears in the Text Editing box.

4 Edit the text in the Text Editing box.

5 Click the Set button.
You must click Set in order for the change to take effect.

6 Repeat the previous steps until you have made all the changes you 
want.

7 Click OK.
The Edit Legend dialog box closes. If you are displaying the legend, 
you will see your changes in the legend text.

Modifying Depth in 
a Two-dimensional 
Graph

A three-dimensional graph plots three fields or variables in three 
dimensions. However, you can add the appearance of a third dimen-
sion to a two-dimensional graph by adding “depth.” The third dimen-
sion does not represent the values of any of the fields or formulas 
plotted in the graph.

By default, 4D Chart adds the illusion of depth to two-dimensional 
graphs. You can remove it to make the values in the graph easier to 
read or modify the three-dimensional illusion.

Text Editing box
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❿❿❿❿ To modify or remove the depth illusion in a two-dimensional graph:

1 Choose View from the Chart menu.
This menu item is enabled only when the currently selected object is a 
graph. 
The Depth dialog box appears.

2 Modify the horizontal and vertical depth, measured in points, by 
typing values in the appropriate text boxes.
To remove the depth illusion, enter zeros in both entry areas. You can 
also enter negative values to invert the three-dimensional illusion axis. 

When you press Tab or click outside a text box, the value you have 
entered is reflected in the Depth preview area.

3 Click OK.
Your Depth specifications are applied to the graph.

Changing the 
Perspective of a 
Three-dimensional 
Graph

You can change the perspective from which a three-dimensional graph is 
viewed. You can change both the rotation and the elevation of a graph.

❿❿❿❿ To change the perspective from which a three-dimensional graph is 
viewed:

1 Choose View from the Chart menu.
The View menu item is enabled only when the currently selected 
object is a graph.

Depth preview 
area
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The 3D View dialog box appears.

2 If you wish, you can change the rotation by entering a new value 
(from 0 to 90) in the Rotation text box or by moving the Rotation 
slider to the left or right.
Rotation is the rotation of the graph around the Values axis.

The model graph reflects the change you have made.

3 If you wish, you can change the elevation by entering a new value 
(from 0 to 90) in the Elevation text box or by moving the Elevation 
slider up or down.
Elevation is the rotation of the graph around a horizontal line, 
perpendicular to the Values axis.

The model graph reflects the change you have made.

4 Click OK.
Your graph is redrawn from the new perspective.

Rotation slider

Elevation slider
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Customize Tips in 
Charts

Tips — information about a graph and its data — are available for both 
XY and non-XY graphs. The user can display tips from any position of 
the pointer in the graph. 

Tips display the following types of information:

■ Value (on which the pointer is located).

■ Ratio between a value (on which the pointer is located) and the total of 
values in that category. This ratio is expressed as a percentage.

■ Category.

The following table lists the graph types and the information that can 
be displayed in the associated tips:

Tip

Type of Graph Tips
2D Column Values and percentages
2D Line None
2D Pie Values and percentages
2D Area None
2D XY Values only
2D Picture Values and percentages
2D Polar Values only
3D Column Values only
3D Line None
3D Area None
3D Surface None
3D Triangle Values only
3D Spike Values only
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The values in the tips are based on the data as displayed in the graph, 
and thus may be approximations based on the screen resolution.

Tip attributes are accessed manually in the Tips dialog box (from the 
Tips item in the Chart menu) or programmatically using the 
commands CT GET TIPS ATTRIBUTES and CT SET TIPS ATTRIBUTES.

The Tips dialog boxes differ for XY and non-XY graphs.

■ XY Graph:

■ Non-XY Graph:

In the Tips dialog box, you can change the properties of the tips 
displayed for any graph.

The Tips list box enables you to select when to display tips. The 
choices are Never, Always, and On Request.

Selecting the Messages in Toolbar option displays the tips in the 
toolbar. If this check box is not selected, the tip will be displayed in an 
independent message box only. The default is to display the tips in the 
toolbar.
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Selecting the Show Category option displays the value of the Category 
axis in the tips. The default is to display the Category axis value.

Selecting the Show Second Category displays the value of the second 
Category axis in the tips. The default is to not show the second 
category. In the case of a 2D graph, selecting this option displays the 
field name of the Category axis value.

Selecting the Show Value option displays the value of the Values axis 
in the tips. The default is to display the Values axis value.

The Display list box enables you to choose to display the category 
value, percentage (the ratio between the value on which the pointer is 
located and the total of values in that category) or both.

The Format list box enables you to select the display format for values 
displayed. The default is General. If the Format selected is General, the 
text box below the Format list box allows you to enter text for the 
Values axis. In the case of XY graphs, there are two Format list boxes 
and text boxes, to accommodate the X and Y Values axes.

Changing the 
Attributes of Chart 
Objects

This section describes how to select individual chart objects (axis lines, 
grid lines, series elements, etc.) and change their graphic attributes, 
such as color, pattern, and line width. You can also change the font 
attributes of chart text objects (such as axis labels and titles).

❿❿❿❿ To select an individual chart object:

■ Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click the object.
The following chart objects can be selected:

■ Each series in a two-dimensional graph

■ Each of the three visible sides of a series in a 3D graph

Note To select all sides of a series in a three-dimensional graph at once, hold 
down the Shift and Ctrl keys (Windows) or Command key (Macintosh) 
and click an object in the series.

■ Each axis (includes the tick marks)

■ Axis labels for each axis

■ Major grid lines for each axis

■ Minor grid lines for each axis

■ Titles for each axis
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■ The legend

■ Values displayed for the series.

Changing Object 
Attributes

After you have selected an object, you can modify its graphic attributes 
using items in the Object menu.

Each of the following object attributes can be changed in the Object 
menu:

■ Fill Pattern  The pattern displayed inside the border of an object. All 
objects except lines have fill patterns. 

■ Fill Color  The color displayed inside the border of an object.

Note The number of colors displayed depends on the number of colors that 
your monitor supports.
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■ Line Pattern  The pattern of a line or border. The default line pattern is 
solid.

■ Line Color  The color of a line or border. The default line color is black. 
The color palette used for Fill Color is also used for Line Color.

■ Line Width  The width of a line or border measured in points. The 
default line width is 0.25 points (also called a hairline).

■ Arrowhead  If the selected object is a line, the Arrowhead menu item is 
enabled. The Arrowhead submenu has the following items.

You can choose to add an arrowhead to either or both ends of the line.

■ Round Corners  If the selected object is a rectangle that you created 
with a rectangle tool, the Round Corners menu item is enabled. When 
you choose Round Corners, the following dialog box appears:
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When you enter a value in the entry area, the preview area shows the 
effect of the value:

Changing Text 
Attributes

Text attributes apply only to axis labels, axis titles, legend text, and 
series values. Each of the following text attributes can be changed in 
the Text menu:

■ Font  The typeface of the text.

■ Size  Font size is measured in points. 

■ Style  Styles include plain, bold, and italic. The default style is plain.

■ Color  The default color is black.

You cannot change the justification of graph text. You can only change 
the justification of text added with the Text tool. For more information 
about adding text with the Text tool, see the section “Adding Text” on 
page 278.

Exploding Wedges 
from a Pie Chart

You can “explode” a pie chart by pulling one or more wedges away 
from the center of the pie. 

❿❿❿❿ To explode a wedge from a pie chart:

1 Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click a wedge of the pie chart to select it.

Exploded 
wedge
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Selection handles appear around the wedge.

2 While holding down the Ctrl key (Command key on Macintosh), click 
and drag the wedge away from the center of the pie.

3 When the wedge is where you want it, release the mouse button and 
the Ctrl key (Command key on Macintosh).

Adding Pictures to a 
Picture Chart

When you create a picture chart, the columns are filled with a default 
picture. You can add your own picture for each series by pasting it from 
the Clipboard.

❿❿❿❿ To paste a picture into the columns for a series:

1 Make sure that the picture you want to paste into the column is on the 
Clipboard.

2 Hold down the Ctrl key (Windows) or Command key (Macintosh) and 
click a picture column for the desired series.

3 Choose Paste from the 4th Dimension or 4D Chart Edit menu.
The picture is pasted into each column for the series.

You can repeat this process for each series. 

Adjusting the 
Pictures Within the 
Columns

To customize the proportions of the pictures within the series 
columns:

1 Double-click the graph to display the Options dialog box for picture 
graphs. 
OR
Select the graph and choose Options from the Chart menu.
The Picture Chart Options dialog box appears.
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In addition to the chart options, which are discussed in section 
“Choosing a Graph Type” on page 221, you will find the following 
options for aligning and adjusting the pictures:

■ Alignment  This option specifies the horizontal alignment of the 
picture: center, left, or right.

■ Vertical  This option specifies how the picture uses the vertical space 
of the column. The options are: clipped, stretched, and stacked. For 
more information about these options, see the table at the end of 
this section.

■ Horizontal  This option specifies how the picture uses the horizon-
tal space of the column. The options are: clipped, stretched, and 
stacked. For more information about these options, see the table at 
the end of this section.

The following table explains the Vertical and Horizontal options.

2 Choose the desired options from the drop-down lists and click OK.

Adding Objects and Text
With 4D Chart you can add a variety of objects to your documents, 
including lines, rectangles, ovals, polygons, and text. You can also add 
dynamic references to fields or to 4th Dimension expressions by 
inserting expressions in text objects.

Option Description

Clipped If the picture is too tall or too wide to be displayed in its 
entirety, it is truncated at the edges of the column. The 
proportions of the picture remain unchanged.

Stretched The picture is stretched or shrunk so that its dimensions 
match those of the column.

Stacked If the picture is either too short or too narrow to fill the 
column, the picture is repeated until the column’s height or 
width is reached. When the edge of the column is reached, 
the picture is truncated.
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The following graph uses objects and text to identify the series.

Topics covered in this section include:

■ Drawing objects

■ Modifying object attributes

■ Adding text

■ Modifying text attributes

■ Adding a dynamic reference to a 4th Dimension field or expression

■ Resizing objects

■ Arranging objects in a document

Drawing Graphic 
Objects

You can draw the following objects:

■ Lines  

■ Rectangles  

■ Rounded rectangles  

■ Ovals  

■ Polygons  

Selecting a Drawing Tool To draw an object, you must first select a tool from the Object Tool 
palette. You make a tool active for drawing when you select it.

The mouse pointer changes depending upon its use. If the Arrow tool 
is selected, then the pointer is an arrow . You use the Arrow tool to 
select menu items and objects.

JBC

Industrial
Average



Chapter 10  Graphs

276 4th Dimension User Reference

When you select any of the graphic object tools, the pointer changes 
to a crosshair . You use the crosshair to draw graphic objects.

Locking a Drawing Tool When you select a tool, it is in effect only while you draw one object, 
after which the Arrow tool is selected. However, you can lock a tool so 
that you can continue to use it as long as you need it, by double-
clicking it. When you lock a tool, it remains in use until you select 
another tool.

Drawing an Object

❿❿❿❿ To draw all objects except polygons:

1 Select a tool in the 4D Chart toolbar. 

1 Hold down the mouse button in the document area and drag the 
mouse to draw the object.

2 Release the mouse button to finish drawing the object.

❿❿❿❿ To draw a polygon:

1 Click to anchor the first vertex.

2 Drag the mouse to draw a side and then click to anchor the next 
vertex.

3 Continue anchoring vertices and drawing sides as necessary.

4 Close the polygon by clicking the first vertex to close the polygon, or 
by pressing Alt+Ctrl+Enter (Windows) or Option+Command+Enter 
(MacOS).
OR
Leave an open side to the polygon by double-clicking the mouse 
button to anchor the last vertex or by pressing Enter.

Open polygonClosed polygon
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Constraining Graphic 
Objects As You Draw

By constraining graphic objects as you draw, you can control the 
drawing process — in particular, the height and width of objects. For 
example, a square is really just a constrained rectangle. 

The following table lists the effects of constraining each object.

Changing Object 
Attributes

Each of the following object attributes can be changed using 
commands in the Object menu:

■ Fill Pattern  The pattern displayed inside the border of an object. All 
objects except lines have fill patterns. The default fill pattern is solid 
white.

■ Fill Color  The color displayed inside the border of an object. All objects 
except lines have fill color. The default fill color is black.

■ Line Pattern  The pattern of a line or border. The default line pattern is 
solid.

■ Line Color  The color of a line or border. The default line color is black.

■ Line Width  The width of a line or border measured in points. The 
default line width is 0.25 points (also called a hairline).

■ Arrowhead  The arrows that appear on one or both ends of a line; only 
lines have arrowheads. The default is to have no arrowheads.

■ Round Corners  The amount of rounding of the corner of a rounded 
rectangle. The default rounding is 1/4 inch.

Object Key Constraint
Lines Shift Constrain line to 45° angles

Rectangles

Shift Draw a square

V (for vertical) Constrain height

H (for horizontal) Constrain width

Rounded 
Rectangles

Shift Draw a rounded square

V Constrain height

H Constrain width

Ovals

Shift Draw a circle

V Constrain height

H Constrain width

Polygons Shift Constrain sides to 45° angles
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Adding Text Most of the text that you want to add to a graph — such as axis labels, 
titles, legends — can be added using menu items in the Chart menu.

To add extra text to a graph, you must first create a text object and 
then enter the text. A text object is a container for text. 

❿❿❿❿ To create a text object:

1 Select the Text tool .
The pointer changes to an I-beam .

2 Hold down the mouse button and drag the mouse to create a 
rectangular text area.

3 Release the mouse button.
You can also simply click in the window after you have selected the 
Text tool to create a text object of default size (three inches in width). 
The default height is determined by the font and font size you have 
selected.

4 If you have not already done so, click inside the text object to insert 
the pointer.
When you place the pointer in the text object, it becomes an insertion 
point .

5 Type your text.

Text object

I-beam pointer

Insertion point
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6 When you have finished typing the text, select any other tool.
Unlike other objects, text objects are not selected after you create 
them. 

Once you have created a text object and added text, you can change 
the text by editing it — for example, copying, cutting, or pasting it. 
You can also change its attributes, such as its font, size, style, and 
justification. For more information about changing text attributes, 
refer to the next section, “Changing Text Attributes”. 

Changing Text 
Attributes

Text attributes are applied only to text inside a text object. Each of the 
following text attributes can be changed in the Text menu:

■ Font  The typeface of the text. 

■ Size  Font size is measured in points. The default size is 12 point.

■ Style  Styles include plain, bold, and italic. The default style is plain.

■ Color  The default color is black.

■ Alignment  Text can be left, right, or center aligned. The default align-
ment left.

Adding Dynamic 
References

Using field references and 4th Dimension expressions, you can create 
4D Chart documents that incorporate information from your database. 
For example, you can use field information from the records to make 
chart titles. You can use 4th Dimension expressions to perform tasks 
such as computing numeric values or concatenating text information.

In this section, you will find information about the following topics:

■ Inserting field values into a 4D Chart document,

■ Inserting a 4th Dimension expression into a 4D Chart document,

■ Displaying field and expression values,

■ Formatting field and expression values,

■ Changing a dynamic reference to static text.

Understanding Values 
and References

You can display the information from 4th Dimension as either values or 
references. A value is the actual information stored in a field or calcu-
lated from an expression. A reference is the name of the field or the 
text of the expression.
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When expressions and fields are displayed as references, they are 
surrounded by the following symbols: « and ». 

For example, a reference to the First Name field in the [Stationery 
Order] table would appear as:

«[Stationery Order]First Name»

4D Chart inserts these symbols when a field is inserted into a text 
object. When you insert any other type of reference, such as a 
4th Dimension function or variable, you must indicate that it is a 
reference. 4D Chart will then add the « and » symbols to differentiate 
the reference from normal text. For more information on referencing 
expressions, see the section “Inserting 4th Dimension Expressions” on 
page 283.

When references are displayed as values, the « and » symbols do not 
appear; for example, a field value for First Name might be:

James

The field value appears as standard text.

Field references and 4th Dimension expressions always refer to the 
current record and are updated whenever the current record changes. 
If there is no current record, no value is displayed. 

Inserting Field 
References

By inserting a field reference in a 4D Chart document, you add 
dynamic information to the document. As the field is updated, so is 
the value in 4D Chart. You can use fields from any table in the data-
base, except subtables.

The field reference or value appears in a text object, except for refer-
ences to picture fields. The text object containing a reference acts as 
any other text object; you can change its attributes, move it, and so on.

■ Using Field References in a Plug-in Window
When you insert a field reference in a 4D Chart plug-in window, the 
value that is displayed when you choose Show Values from the 
Database menu is the field’s value for the current record. If no record is 
currently loaded there will be no value displayed in the 4D Chart plug-
in window. 



Adding Objects and Text

2814th Dimension User Reference

In order to show the value stored in a field for a particular record, make 
sure that the record is loaded — by displaying the record in an input 
form, for instance. If the current record changes, the value displayed in 
the field changes.

■ Using Field References in a 4D Chart Area on a Form
When you insert a field reference in a 4D Chart area on an input form, 
the value that is displayed when you choose Show Values from the 
Database menu is the field’s value for the current record.

You can use the Paste Field dialog box to paste a field reference into a 
document.

❿❿❿❿ To paste a field reference into a 4D Chart document using the Paste 
Field dialog box:

1 Click the mouse button where you want to insert the reference.
If you click inside a text object, you cannot insert a Picture field.

2 Choose Paste Field from the Database menu.
The Paste Field dialog box appears. All tables in the database are listed 
in the Tables drop-down list. The fields for the selected table are 
displayed in the Fields list.

3 Select the table from which you wish to paste a field reference from 
the Tables drop-down list.
The fields in the selected table are displayed in the Fields list.

4 Select the field you wish to paste from the Fields list and click OK.
A reference to the field is pasted into the document in a text object.

Tables drop-down list

Fields list
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You can select fields from a drop-down list containing all available 
tables and fields. You cannot paste references to Picture fields when 
you select a field from a drop-down list.

When you are working in a form, you can choose fields from a drop-
down list that displays the fields in the current table, or from a drop-
down list of fields for all tables in the database. 

When you use 4D Chart in a plug-in window, the drop-down list 
always contains both tables and fields. 

❿❿❿❿ To insert a field into a 4D Chart document using the Tables and Field 
pop-up menu:

1 Create a text object where you want to paste the field.
If you need information about creating text objects, see the section 
“Adding Text” on page 278.

2 Position the I-beam pointer  over the text object.
Make sure that the insertion point is in the text object.

3 To choose a field from the same table as the form, hold down the Alt 
key (Windows) or Option key (Macintosh) as you press the mouse 
button.
A pop-up menu of fields for the table in which you are working 
appears. If you are working in a plug-in window, the pop-up menu 
contains both tables and fields.

4 To choose a field from another table, hold down the Shift and Alt 
(Windows) or Option (Macintosh) keys while you press the mouse 
button. 
If you are working in a plug-in window, you do not need to hold down 
the Shift key.

4D Chart displays a hierarchical pop-up menu of the tables in the 
database. Each table has a submenu containing its fields. 

5 Select a field.
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A reference to the selected field is pasted into a text object in the 
4D Chart document at the insertion point location.

Inserting 4th Dimension 
Expressions

You can insert any valid 4th Dimension expression into a document. 
The expression can be a 4th Dimension variable, a 4th Dimension func-
tion, a plug-in function, or a method that returns a value.

With expressions you can use the power of 4th Dimension’s language 
within 4D Chart documents. You can perform calculations, concate-
nate information from several fields, and so on. 

The following table contains some examples of expressions:

An expression is evaluated only when you perform one of the 
following actions:

■ Open the document

■ Choose Show Values from the Database menu

■ Print the document

For more information about expressions, refer to the 4th Dimension 
Language Reference. 

❿❿❿❿ To insert a 4th Dimension expression into a 4D Chart document:

1 Create a text object where you want to place the expression.
Since the expression is created from text, you must first create the text 
object.

2 Enter the expression text and then select it.

3 Choose Reference from the Database menu.
The text is now enclosed in the « and » symbols, which indicate that it 
is an expression:

«Current date»

4 When you have finished, select the Arrow tool.
To display the value of the reference, choose Show Values from the 
Database menu.

Expression Comment
vDate A variable containing a date
Current date A 4th Dimension function
Current date–vDate A statement that performs a calculation
DateCalc A method that returns a value



Chapter 10  Graphs

284 4th Dimension User Reference

Displaying Values or 
References

When you display values, you show the actual values stored in refer-
enced fields and the values calculated by referenced 4th Dimension 
expressions. For example, if the reference is «Current date», today’s date 
is displayed. 

❿❿❿❿ To display values:

■ Choose Show Values from the Database menu.
The value of each reference is displayed.

Note The values of all references are displayed, regardless of the selected 
reference.

❿❿❿❿ To display references:

■ Choose Show References from the Database menu.
The reference for each value is displayed.

Changing the Value in a 
Reference to Text

You can change the value in a dynamic reference into static text that 
will not be updated when the value changes. 

For instance, you can use the 4th Dimension expression «Current date» 
to display the date you created a graph, and then change that date to a 
static text object. No matter what the current date is, the text object 
will always display the creation date of the graph.

Changing a value to text is called unreferencing the value, because the 
value no longer has a dynamic reference to the database. Once you 
have unreferenced a value, you cannot change it back to a reference. 

❿❿❿❿ To change a value in a field reference or expression to text:

1 Choose Show Values from the Database menu to display all values.

2 Select the text block containing the value you want to unreference.
If the text block contains more than one field or expression, select only 
the value you want to change.

3 Choose Unreference from the Database menu.
The value becomes text.

Changing a Reference to 
Text

You can change a reference into text by unreferencing it. When you 
change a reference to text, you change the words of the reference, not 
the value to which the reference refers. 
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For instance, if you change the reference «Current date» to text, the text 
object displays the following:

Current date

When you choose Show Values from the Database menu, this text does 
not change, and the current date is not displayed, because the text no 
longer refers to a 4th Dimension expression.

You may want to edit a reference or permanently change it to standard 
text. If you want to edit a reference, you must unreference it, edit it, and 
then reference it again. 

❿❿❿❿ To unreference a field reference or expression:

1 Choose Show References from the Database menu to display all 
references.

2 Select the text block containing the reference you want to 
unreference.
If the text block contains more than one field or expression, select only 
the reference you want to change.

3 Choose Unreference from the Database menu.
The « and » symbols are removed, and the reference becomes text.

Formatting References You can use a display format for the value of any numeric, date, or 
time field or expression in 4D Chart. For instance, you can use a 
display format to display dollar amounts using the dollar sign ($), 
commas, and decimals. 

The following table shows some examples of display formats:

❿❿❿❿ To format a reference:

1 Select the reference.
Since the entire expression is a single value, you can select it by 
clicking it with the Text tool.

2 Choose Format from the Database menu.

Data in Default Format Display Format Data in Display Format
3400 $###,##.00 $3,400.00
3/4/03 Month Date, Year March 4, 2003
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The Field Format dialog box appears.

3 Select an appropriate format from the list.
The format appears in the text box below the list of formats.

If you want, you can edit a number format or enter a new number 
format in the Format text box. You cannot edit date or time formats.

For more information about display formats, refer to the 
4th Dimension Design Reference manual.

4 Click OK.
The format is listed after the reference. For instance:

«Current date; Abbr.: Month Day, Year»

When you choose Show Values, the value of the reference is displayed 
using the format.

Resizing Objects You can make an object larger or smaller by resizing it. You can select 
one or more objects to resize. If you select more than one object, all 
selected objects are resized by the same amount. 

You can resize the height and width at the same time, maintaining the 
sizing proportion between the two. 

❿❿❿❿ To resize an object:

1 Select the object.

2 Hold the mouse button down on a selection handle and drag it up, 
down, or diagonally to change the object’s size.

Format list

Edit format area



Adding Objects and Text

2874th Dimension User Reference

If you drag a corner, the height and width change. If you drag a side 
either the height or the width changes.

To display the object’s outline — rather than its rectangular frame —
hold down the Alt key (Option key on Macintosh) while resizing. 

To resize the object so that the height and width retain the same 
proportion to each other, hold down the Shift key while you are 
resizing.

3 Release the mouse button when you have finished.
The object is resized.

Arranging Objects When you have two or more objects in a 4D Chart document, you can 
use the items in the Arrange submenu of the Object menu to arrange 
them. The Arrange submenu is shown below.

You can choose from the following actions in the Arrange submenu:

■ Bringing an item to the front 

■ Sending an item to the back 

■ Moving an item forward one level

■ Moving an item backward one level

Object’s frame

Object
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■ Aligning objects in relation to each other

■ Grouping a set of objects

■ Ungrouping a set of objects.

The following sections describe these actions in more detail.

Changing the Stacking 
Order

When you draw objects, they can partially or entirely overlap one 
another. The order in which objects are placed when they overlap one 
another is called the stacking order. The sample screen below displays 
several objects and their stacking order.

As you work with objects, you may want to change the stacking order 
of objects; to do so, you can move one or more objects in front of or 
behind other objects.

■ Moving an Object in Front of All Others  By moving an object in front 
of all others, you move it to the top layer.

■ Moving an Object Behind All Others  By moving an object behind all 
other objects, you move it to the bottom layer.

■ Moving One Object in Front of Another  Moving an object in front of 
another object allows you to move the selected object one layer higher 
— that is, place it closer to the top layer.

■ Moving One Object Behind Another  Moving an object behind 
another object allows you to move the selected object one layer lower 
— that is, place it closer to the bottom layer.

❿❿❿❿ To modify the stacking order:

1 Use the arrow pointer to select an object.

2 Choose a command on the Arrange submenu in the Object menu. 

Middle object

Top object

Bottom object
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The Arrange submenu is shown below.

Aligning Objects When you align objects to each other, you position them in relation to 
each other. Aligning objects to each other ensures that objects are 
placed precisely in relation to each other. You can align objects both 
horizontally and vertically. 

The object that is farthest in the selected alignment direction is the 
reference for object alignment. For example, if you want to align the 
left sides of several selected objects, the selected object that is furthest 
to the left remains fixed, and the other objects are aligned to it.

When you select Align Objects from the Arrange submenu, the 
Align Objects dialog box appears:

Use the following icons to align the selected objects to each other:

Vertical alignment buttons

Model objects

Horizontal alignment buttons

Icon Meaning

 Align the left edges of selected objects.
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Select a maximum of one vertical and one horizontal alignment. The 
model objects move to indicate the effects of the alignment.

Note To deselect an icon, click it again.

❿❿❿❿ To align objects:

1 Select the objects to be aligned.
Shift-click to select several objects.

2 Choose Align Objects from the Arrange submenu of the Objects menu.
The Align objects dialog box appears.

3 Click the desired alignment icons and click the Align button.

Grouping and 
Ungrouping Objects

By grouping objects, you can combine several objects into one. A 
grouped object acts like a single object when you manipulate or edit it. 
You can work with a grouped object as you would any other object; 
you can change its attributes, resize it, and so on.

When you group several objects, all attributes of the individual objects 
are retained. However, if you change any attribute of the group, that 
change affects all objects in the group. For example, if you select a new 
fill pattern for the group, it is applied to each object in the group. 

Ungrouping an object breaks it into its component objects. When an 
object is ungrouped, each piece becomes a separate object again. 
Ungrouped objects retain any changes made to them while part of a 
group.

You can make a single object from several selected objects by grouping 
them. Once you create a group, you can manipulate it the same way 
you would a single object.

 Align the centers of select objects along a vertical axis.

 Align the right edges of selected objects.

 Align the top edges of selected objects.

 Align the centers of select objects along a horizontal axis.

 Align the bottom edges of selected objects.

Icon Meaning
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❿❿❿❿ To group objects:

1 Select all objects to group.

2 Choose Group from the Arrange submenu of the Object menu.
The objects become one object.

You can break a grouped object into its separate objects by ungrouping it.

❿❿❿❿ To ungroup objects:

1 Select an object to ungroup.

2 Choose Ungroup from the Arrange submenu of the Object menu.
The object is ungrouped and each object is selected.

Printing 4D Chart Documents
You can print any 4D Chart document. This section discusses printing 
4D Chart documents in the following ways:

■ As a single 4D Chart document

■ As part of a 4th Dimension form

■ As a part of a print merge, in which you print a 4D Chart document for 
each record in a selection of records

Setting the Print 
Order

The order in which a multi-page document is printed (either horizon-
tally or vertically) is determined by the print order selected in the Prop-
erties dialog box. You can select printing by row , or printing by 
column . The print order affects only the order in which the docu-
ment prints; it does not affect the page orientation. The default is to 
print pages by row.

❿❿❿❿ To set the order in which a multi-page document is printed:

1 Choose Properties from the 4D Chart Edit menu.



Chapter 10  Graphs

292 4th Dimension User Reference

The Properties dialog box appears.

2 Click the desired Print Order icon.

3 Click OK.

Printing the 
Document

You can print 4D Chart documents from a plug-in window or from a 
4D Chart area in a form. If the document is more than one page in 
length, you can select the pages you want to print.

❿❿❿❿ To print a document:

1 Choose Print from the 4D Chart File menu.

The Print dialog box appears.

2 Select options as necessary.

3 Click the Print button to begin printing.

Printing a 4D Chart 
Area as Part of a 
Form

If a 4D Chart area is on a 4th Dimension form, you can print it with 
the record. In this case, you print from 4th Dimension, rather than 
from 4D Chart. 

Before printing, be sure to select the records you want to print. For 
more information about selecting records in 4th Dimension, see 
Chapter 4, “Selecting Records”, on page 81.

Print 
Order icons
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❿❿❿❿ To print a 4D Chart document as part of a record:

1 Choose Print from the 4th Dimension File menu.
A dialog box appears so that you can choose the print form.

2 Choose the print form.

3 Click OK.
The Page Setup dialog box appears.

4 Select options from the Page Setup dialog box as necessary.

5 Click OK.
The Print dialog box appears.

6 Select options as necessary.

7 Click the Print button when you want to begin printing.
The selected records are printed, including the 4D Chart documents.

Creating a Print 
Merge

You can perform a print merge of a 4D Chart document. Performing a 
print merge allows you to print a 4D Chart document for each record 
in a selection of records.

Note The values in any graphs in the document are not updated for each 
record.

Print merges are most useful when performed from 4D Chart plug-in 
windows. 

You can perform print merges only for documents that contain 
references to 4th Dimension fields. The value in a field reference is 
determined by the current record being printed. The advantage to 
performing a print merge is that you can print a document for an entire 
selection of records without having to load and print for each record 
separately. 

Note For information on adding field references, see the section “Inserting 
Field References” on page 280.
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❿❿❿❿ To perform a print merge:

1 Choose Print Merge from the 4D Chart File menu.

The Create Merge Selection dialog box appears. 

2 Choose the table whose records should be included in the print merge. 
The dialog box displays the number of records currently selected for 
that table. 

4D Chart will print the document only for the selected records. 

3 If you want to change the selection of records, click the Query button. 
The 4th Dimension Query editor appears. After you do the query in the 
Query editor, you will return to the Create Merge Selection dialog box. 
For more information about the 4th Dimension Query editor, see the 
section “Query Editor” on page 90.



Printing 4D Chart Documents

2954th Dimension User Reference

4 If you want the selected records to be sorted, click the Order by 
button. 
The 4th Dimension Order By editor appears. After you sort the records, 
you will return to the Create Merge Selection dialog box. For more 
information about the Order By editor, see the section “The Order By 
Editor” on page 123.

When you have selected the appropriate records, you can print the 
records.

5 Click OK in the Create Merge Selection dialog box.
The Print dialog box appears.

6 Select the appropriate options and click OK.
4D Chart prints the document for each record in the selection.


